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Typographic Conventions

Use of notes

Notes containing important information are clearly identified as follows:

NOTE Note text

Use of examples

Examples containing important information are clearly identified as follows:

Example Example text

�

Numbering in figures and illustrations

Reference numbers in figures and illustrations are shown with white numbers in a black circle
and the corresponding explanations shown beneath the illustrations are identified with the
same numbers, like this:
� � � �

Procedures

In some cases the setup, operation, maintenance and other instructions are explained with
numbered procedures. The individual steps of these procedures are numbered in ascending
order with black numbers in a white circle, and they must be performed in the exact order
shown:

� Text

� Text

� Text

Footnotes in tables

Footnote characters in tables are printed in superscript and the corresponding footnotes
shown beneath the table are identified by the same characters, also in superscript.

If a table contains more than one footnote, they are all listed below the table and numbered in
ascending order with black numbers in a white circle, like this:

� Text

� Text

� Text

Character formatting and orientation aids

Menu names, menu commands, submenu commands, and dialog box options are printed in
boldface type. Examples: The menu item New in the menu Project or the options PLC inter-
face and Computer Link in the dialog box Transfer-Setup.

Please keep this manual in a place where it is always available for the users.





GX IEC Developer Beginner's Manual IX

Contents

Contents

1 Introduction

1.1 This manual… . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-1

1.2 The Reference Manual... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-1

1.3 If you are not yet familiar with MS Windows ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-1

1.4 If you are not yet familiar with the IEC 61131-3 standard... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-1

1.5 If you already have IEC 61131-3 experience and
want to get to work right away... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-1

1.6 If you get stuck... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-2

2 Getting to Know GX IEC Developer

2.1 What's New in GX IEC Developer? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-1

2.2 Introduction to the IEC 61131-3 Standard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-2

3 Basic Terms Used in IEC 61131-3

3.1 Projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-1

3.2 Program Organisation Units (POUs) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-2

3.3 Programs, Function Blocks and Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-3

3.4 Parameters and Instancing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-4

3.5 Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-5

3.6 Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-6

3.7 Programming Languages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-9

3.7.1 Networks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-9

3.7.2 The Text Editors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-9

3.7.3 The Graphical Editors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-14

4 Installation

4.1 Hardware Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-1

4.1.1 Recommended Hardware Configuration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-1

4.1.2 Software Requirements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-1

4.2 Copyright . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-1



X MITSUBISHI ELECTRIC

Contents

4.3 Installing GX IEC Developer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-2

4.3.1 Installing GX IEC Developer on your hard disk. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-2

4.3.2 Starting GX IEC Developer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-2

4.3.3 Quitting GX IEC Developer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-2

5 The User Interface

5.1 The Elements of the User Interface. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-1

5.1.1 The Menu Bar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-2

5.1.2 The Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-2

5.1.3 Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-2

5.1.4 The Status Bar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-2

5.1.5 The Project Navigator . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-3

5.2 Declaration Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-4

5.3 The Editors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-5

5.3.1 Using the text editors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-5

5.3.2 Using the graphical editors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-6

6 Getting Started

6.1 Step 1: Creating New Projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-2

6.2 Step 2: Creating Tasks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-4

6.3 Step 3: Declaring Global Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-5

6.4 Step 4: Creating Program Organisation Units . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-7

6.5 Step 5: Programming POU Headers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-8

6.6 Step 6: Programming POU Bodies . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-9

6.7 Programming Examples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-10

6.7.1 Inputs and outputs in ladder diagram language (LD) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-10

6.7.2 A Sum Function in FBD Language . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-12

6.7.3 I/O Signal Configuration Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-14

6.7.4 Timers in LD/FBD/IL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-15

6.7.5 Sequential Function Chart Language . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-20

6.8 Step 7: Checking PLC Programs (syntax check) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-36

6.9 Step 8: Configuring Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-37

6.10 Step 9: Compiling Projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-39

6.11 Step 10: Communications Port Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-40



GX IEC Developer Beginner's Manual XI

Contents

6.12 Step 11: Downloading Programs (to PLC) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-41

6.13 Step 12: Monitoring Programs. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-42

6.14 Step 13: Uploading Data from the CPU. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6-43

7 Sample Program: CarPark

7.1 Project Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-1

7.1.1 The Task "Main" . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-1

7.1.2 The Task "Door_Operate" . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-2

7.2 Create the new "CarPark" project (Step 1) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-2

7.3 Create the tasks (Step 2). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-2

7.4 Declare the global variables (Step 3) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-2

7.5 Create the program organisation units (Step 4) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-3

7.5.1 Project Navigator Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-3

7.6 Program the headers (Step 5) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-4

7.6.1 Header of the "Control" POU . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-5

7.6.2 Header of the "Counter" POU . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-5

7.6.3 Header of the "Door_Control" POU . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-5

7.7 Program the bodies (Step 6) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-6

7.7.1 Body of the "Control" POU . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-6

7.7.2 Body of the "Counter" POU. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-7

7.7.3 Body of the "Door_Control" POU . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-8

7.8 Configure the tasks (Step 8) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-9

7.8.1 The "Main" task . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-9

7.8.2 The "Door_Operate" Task . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7-10

8 Importing



XII MITSUBISHI ELECTRIC

Contents



1 Introduction

1.1 This manual...

...is a compact guide to using GX IEC Developer, suitable both for beginners and experienced
users upgrading from other systems. The manual includes explanations of the terms and
structural concepts of IEC programming and an introduction to the new IEC 61131-3 standard.
The "Getting Started" chapter provides a precise step-by-step description of how to use GX
IEC Developer, including a sample project.This executable application is used to demonstrate
the operation of the program with the help of the exercises provided in this manual.

1.2 The Reference Manual...

... contains detailed descriptions of all menus and menu options.Refer to it whenever you need
more comprehensive information on the ins and outs of the system.

1.3 If you are not yet familiar with MS Windows ...

...please at least read the Windows Fundamentals section in the Windows User's Guide, or work
through the Windows Tutorial accessible through the Help menu of the Windows Program Man-
ager.This will teach you what you need to know about using the basic elements of MS Windows,
and the operating procedures that are identical in all Windows application programs.

1.4 If you are not yet familiar with the IEC 61131-3
standard...

... please do take the time to read the "Introduction to the IEC 61131-3 Standard" chapter.
This section explains the most important new terms and concepts of this industrial standard.
A glossary of all the terms is provided in the Appendix of the Reference Manual.

1.5 If you already have IEC 61131-3 experience and
want to get to work right away...

... then you can go straight to the "Getting Started" section for immediate results. This chapter
provides clear, step-by-step descriptions of all important GX IEC Developer operations, from
creating a new project to downloading your finished program to the controller.
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1.6 If you get stuck...

...do not despair, help is never far away! If you run up against seemingly insoluble problems, or if
you have questions about GX IEC Developer or the connected programmable logic controller
(PLC) configuration, please first refer to the manuals and documentation. Many answers and
solutions can also be found directly in the GX IEC Developer context-sensitive online help
system, which can always be accessed by pressing the � key. Make use of the Search com-
mand in the Help menu as well, as this will often locate the information you need. If you can't find
answers to your questions in any of these places, contact your local MITSUBISHI ELECTRIC
representative or call our European headquarters in Ratingen directly. The addresses and
phone numbers are provided on the back covers of all our manuals.
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2 Getting to Know GX IEC Developer

2.1 What's New in GX IEC Developer?

GX IEC Developer is a Windows program:

GX IEC Developer uses the graphical user interface of MS Windows for fast, intuitive operation.
This means that instead of labouriously searching through a labyrinth of program structures,
you can implement your controller applications quickly and efficiently.

GX IEC Developer increases your productivity:

The modular architecture of GX IEC Developer brings big advantages for complex program-
ming projects.Frequently-needed program blocks and functions only need to be created once.
Thanks to the building block system you can then insert them again and again wherever and
whenever required. This significantly reduces your programming overheads, enabling you to
make major changes to your programs with just a few simple operations.

GX IEC Developer is a multi-language system:

GX IEC Developer supports programming in different languages. Several graphical and
text-based editors help you to write tailor-made programs quickly and easily, choosing the lan-
guage that best suits the problem.

GX IEC Developer is your link to the IEC world:

GX IEC Developer supports the new IEC 61131-3 standard for PLC (programmable logic con-
troller) programming. This standard lays down the specifications for standardised PLC control
programs.
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2.2 Introduction to the IEC 61131-3 Standard

IEC 61131-3 is the new international standard for PLC programs, defined by the International
Electrotechnical Commission (IEC). It defines the programming languages and structuring
elements used for writing PLC programs.

Structured Programming

The structured programming approach replaces the former unwieldy collection of individual
instructions with a clear arrangement of the program into individual program modules. These
modules are referred to as Program Organisation Units (POUs), which form the basis of this
new approach to programming.

There are three different classes of POUs, classified on the basis of their functionality:

� Programs

� Functions

� Function blocks

POUs declared as functions and function blocks are effectively programming instructions in
their own right, and they can be used as such in every module of your programs.
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Fig. 2-1:
Program organisation units (POUs)
are used to implement all
programming tasks.
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The final program is assembled from the POUs that you define as programs. This process is
handled by the task management, in the Task Pool. Program POUs are put together in groups
referred to as Tasks.
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Fig. 2-2:
The program POUs are grouped
together in tasks.
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The Sequential Function Chart language (SFC) is also an aid for writing structured
PLC programs. It is particularly well suited for programming sequential operations.

Programming Languages

The actual PLC program code contained in the program organisation units (POUs) and the
steps and transitions of an SFC sequence can be written in any of the available programming
languages. The language used will depend on the nature and size of the programming task.

� The Text Editors:
Instruction List (IL)
Structured Text (ST)

� The Graphical Editors:
Ladder Diagram (LD)
Function Block Diagram (FBD)
Sequential Function Chart (SFC)
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Fig. 2-4:
An SFC sequence consists of a series
of steps and transitions
(transition or continue conditions).
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Variables

Before you can actually start writing a PLC program you must first decide what variables you
are going to need in the program module you are working on.Each POU has a list of local vari-
ables, which is where the variables that can only be used within that POU are defined and
declared. The global variables, which can be used by all the POUs in the program, are
declared in a separate list.
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Fig. 2-5: Global and local variables
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3 Basic Terms Used in IEC 61131-3

3.1 Projects

Every GX IEC Developer project consists of the following elements:

� The Library Pool:
- the programming instructions contained in the standard library
- the programming instructions contained in the manufacturer library

� The PLC parameters

� The tasks in the Task Pool

� The structured data types in the DUT Pool

� The global variables

� The program organisation units in the POU Pool
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Fig. 3-1
The program element objects are displayed in the
Project Navigator window.



3.2 Program Organisation Units (POUs)

Each program organisation unit consists of

� a header and

� a body.

The variables to be used in the POU are defined (declared) in the header.

The body contains the actual PLC program.

POUs are divided into three classes on the basis of their functionality:

� Programs [PRG],

� Functions [FUN] and

� Function blocks [FB]
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Fig. 3-2: POU header (top) and POU body (bottom)



3.3 Programs, Function Blocks and Functions

The program POU is the standard program organisation unit.Program POUs can contain pro-
gramming instructions from libraries, functions and function blocks. The execution of the pro-
gram POUs is controlled by tasks.

POUs declared as functions or function blocks are independent program elements.
They function effectively as programming instructions that can be replaced whenever neces-
sary, and they can also be used in other program modules, just like ordinary instructions.

NOTES Function blocks can be called by program POUs and other existing function blocks, but not
from functions. The function blocks themselves can contain programming instructions from
the libraries, functions and other existing function blocks.

Function blocks pass one or more output variables as their result.All the values of the output
variables and the internal values within the function block are stored following execution of
the function block. These values are then used the next time the function block is invoked.
This means that invoking the same function block twice with the same input parameters
does not necessarily result in the same output values!

Functions can be called by program POUs, function blocks and other existing functions.
Functions can contain programming instructions from the libraries and other existing
functions.

Functions always pass an output value, and they do not store any internal status information.
Thus, you should always get the same output value every time you invoke a function with the
same input parameters.
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Item Function Block Function

Internal variable storage Storage No storage

Instancing Required Not required

Outputs
No output
One output
Multiple Outputs

One output

Repeated execution with same
input values

Does  not always deliver the same
output value

Always delivers the same output
value

Tab. 3-1: Differences: Function Blocks and functions

Fig. 3-3:
Programs, function
blocks, and functions
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3.4 Parameters and Instancing

Functions and function blocks have formal parameters and actual parameters. Formal
parameters are the variables used when a function or function block is created. The formal
parameters of the programming instructions in the standard and manufacturer libraries are not
visible to the user.Actual parameters are the variables that are passed to the function or func-
tion block instance (copy) when it is used in another POU. Actual parameters can be defined
variables, hardware addresses or constants.

Function blocks can only be called as instances. The process of "instancing", or making a
copy of the function block, is performed in the header of the POU in which the instance is to be
used. In this header the function block is declared as a variable and the resulting instance is
assigned a name. Note that you can declare multiple instances with different names from one
and the same function block within the same POU. The instances are then called in the body of
the POU and the actual parameters are passed to the formal parameters. Each instance can
be used more than once. For details on activating instances of function blocks in the individual
editors please refer to the chapter "Programming Languages".
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Fig. 3-4: The program organisation unit POU_9 is a function block
[FB]. The variables "IN" and "OUT" used in this program
module are declared in the header. "IN" and "OUT" are
the formal parameters.

Fig. 3-5: "Reset" is an instance of function block POU_9.
"IN" and "OUT" are the formal parameters;
"TimerS1" and "ComeIn" are the actual
parameters of the instance.



3.5 Tasks

A task contains one or more program organisation units declared as programs [PRG].
The task controls the processing of these programs by the controller.

If a project contains more than one task you can define execution conditions for the
individual tasks:
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Fig. 3-6: This project consists of two tasks, TASK_1 and TASK_2.

Fig. 3-7:
Event: Execute, if the variable is TRUE.
Interval: Execute at defined time intervals
Priority: Execute in a defined priority order



3.6 Variables

Variables are similar to operands. They contain the values of inputs, outputs or the internal
memory locations of the PLC system.

A distinction is made between two different variable types, on the basis of their "scope" within
the program as a whole:

� Global variables

� Local variables

Global variables are created for the entire project. They have global scope; this means that
they are accessible from all POUs, thus making it possible to exchange data between the indi-
vidual modules that make up the entire PLC program project.

Local variables' scope only applies for a single specific POU. They cannot be used or refer-
enced in other POUs.

Declaring Variables

Before you can begin with the actual programming, you should declare the variables you are
going to use in the project as a whole (global variables) and in the individual POUs
(local variables).

Each variable declaration has the following elements:

� Class

� Autoextern option (global variables only),

� Identifier,

� Absolute address (global variables only),

� Data type,

� Initial value (automatically),

� Comment (optional),

� Remark (optional).
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Fig. 3-8: The declaration table for local variables in the
header of the POU_9 function block



Class

The class keyword assigns the variable a specific property that defines how it is to be used in
the project.

Identifiers and Absolute Addresses

Each variable is given a symbolic address, i.e. a name. This is referred to as the identifier;
it consists of a string of alphanumeric characters and underline characters.The identifier must
always begin with a letter or an underline character. Spaces and mathematical operator char-
acters (e.g. +, -, *) are not permitted.

Examples of identifiers: FAULT
ZEROSIG
LIM_SW_5

When global variables are declared they should also be assigned absolute addresses that
reference the memory location of the variable in the CPU or a physical input or output. If you do
not assign the absolute addresses manually, they are assigned automatically.

When local variables are declared in the header of the POU they are automatically assigned a
suitable memory location in the CPU.

You can use either the IEC syntax (IEC-Addr.) or the MITSUBISHI syntax (MIT-Addr.) to assign
the absolute addresses. Two address columns are available.

As soon as you have entered an address in one of these columns, the other address also
appears. You can enter either of the two address formats in both columns. If, for instance, you
enter a MITSUBISHI address in the IEC column, GX IEC Developer identifies it immediately,
places it in the correct column and produces the matching IEC address in the other column.

Use upper case letters only and no spaces or mathematical operator characters
(e.g. +, -, *) in addresses.
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Class
Use in POUs:

Meaning
PRG FUN FB

VAR X X X Variable that is only used within the POU

VAR_CONSTANT X X X Local variable with unchangeable initial value used
within the POU

VAR_INPUT — X X Variable passed from outside that cannot be altered
within the POU

VAR_OUTPUT — — X Variable passed (output) by the POU

VAR_IN_OUT — — X Local variable passed from outside and passes
(output) by the POU, can be altered within the POU

VAR_EXTERNAL X — X Global variable used in the POU header

VAR_EXTERNAL_CONSTANT X — X Global variable with unchangeable initial value used in
the POU header

VAR_GLOBAL X — X Global variable declared in the Global Variable List

VAR_GLOBAL_CONSTANT X — X Global variable with unchangeable initial value
declared in the Global Variable List

Tab. 3-2: Available classes

IEC Address MITSUBISHI Address Meaning

%QX0 Y0 Output Y0

%IX31 X1F Input X1F

%MW0.450 D450 Data register D450

Tab. 3-3: Examples of absolute addresses



Data Types

The data type of a variable defines the number of bits it contains, how they are processed and
the variable's value range. The following data types are available.

Initial Value

The initial values are set automatically by the system and cannot be changed by the user.

Comment

You can add a comment up to 64 k characters long for each variable.

Remark

You can add additional user information.

Autoextern option

Global variables activated in the Autoextern column are automatically added to all existing and
new POUs (programs and function blocks only).
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Data type Value range Size

BOOL Boolean 0 (FALSE), 1 (TRUE) 1 bits

INT Integer -32.768 to 32.767 16 bits

DINT Double integer -2.147.483.648 to 2.147.483.647 32 bits

WORD Bit string 16 0 to 65.535 16 bits

DWORD Bit string 32 0 to 4.294.967.295 32 bits

REAL Floating-point value 3.4 +/- 38 (7 digits) 32 bits

TIME Time value
T#-24d-0h31m23s648.00ms

to
T#24d20h31m23s647.00ms

32 bits

STRING
(Q series only) Character string max. 50 characters

Tab. 3-4: Available data types



3.7 Programming Languages

GX IEC Developer supports five programming languages: Two text languages, two graphical
languages, and one structuring language.

� Text language:
Instruction List language IL (IEC IL and MELSEC IL), Structured Text ST

� Graphical languages:
Ladder Diagram language LD, Function Block Diagram language FBD

� Structuring language:
Sequential Function Chart language SFC

E
WARNING:
You cannot change the programming language once you have selected it. Even though
it is physically possible to switch to another language, you will lose the entire contents
of the unit's body if you attempt to do so!

3.7.1 Networks

In all the editors - with the exception of the SFC editor and ST editor - your PLC program is
divided into a number of program sections referred to as networks. Each network is assigned
a name (the network label) which can be used as a destination for jump (goto) instructions.

NOTE Each network can contain no more than one contiguous circuit unit.

3.7.2 The Text Editors

The following text editors are supported:

� MELSEC Instruction List

� IEC Instruction List

� Structured Text

The structure of all Instruction List types is identical. Each Instruction List consists of a
sequence of controller instructions. Each controller instruction begins on a new line and con-
sists of a programming instruction and its parameters and variables.However, there are signif-
icant differences in the way the controller instructions are executed.

The MELSEC Instruction List Language (MELSEC IL)

MELSEC Instruction List programs are written following the rules of DIN 19239 and the pro-
gramming rules familiar from the MELSEC MEDOC software. You can only use genuine
MELSEC programming instructions (see Appendix of the Reference Manual). MELSEC
Instruction List programs can only contain MELSEC networks. Access to IEC programming
instructions is not possible.
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The IEC Instruction List Language (IEC IL)

The IEC Instruction List language allows you to combine IEC networks and MELSEC networks
in a single program.

The IEC networks are programmed according to the IEC 61131-3 rules, and you can use both
IEC programming instructions and the adapted MELSEC instructions (see Appendix in Refer-
ence Manual).

Structured Text (ST)

ST is a text-oriented editor (programming language), similar to PASCAL and supports mathe-
matical functions and a simple creation of loops.

ST body does not contain a network list because it always consists of only one network.

ST is an editor from the IEC 61131 programming standard. The Structured Text editor is com-
patible to the IEC 61131-3.

All IEC 61131 (IEC 61131-3: PART3-1992) standard functions are supported.

All MELSEC instructions are supported.
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�

Fig. 3-9:
Combined Instruction List
networks

	




Number Description

� MELSEC network

�
Network label To enter the network label "NET_01:"
first double-click on the network bar.

� EC network

� Network bar


 Comment text must be enclosed between (* and *) character pairs.

	 The "CJ" instruction performs a jump to the specified destination network.

Tab. 3-5: Key to figure above

Fig. 3-10.
Structured Text body



The Accumulator

In the IEC editor the result of each operation is stored in an accumulator directly after execution.
This accumulator always contains the operation result of the last instruction programmed.

NOTE You do not have to program input conditions (execution conditions) for the operations in this
editor. Execution is always based on the contents of the bit accumulator.

Example The following illustrates the difference between programming in the MELSEC and IEC editors.
We want to program the addition D0(5)+D1(10) = D2(15) to be executed when input X0 is active.

�
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Fig. 3-11:
Code for the addition ...

... in the IEC editor

... in the MELSEC editor

�

�
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�

�




Number Description

� The bit accumulator is undefined at the beginning of the network.

� The accumulator now contains a value of 0 or 1, depending on the state of input X0.

�

The JMPCN instruction (JumpConditionalNot) will be executed if the value in the accumulator is 0.
The instructions in section � are skipped and the program branches to the "Next:" network.
If the value in the accumulator is 1, JMPCN is ignored and the instructions in � are executed.
The accumulator then still contains the status of X0, i.e. 1 in this case.


 Writes the contents of data D0, i.e. 5, to the accumulator.

	 Adds the value in D0 to the value in D1. After the addition the result (15) is stored in the accumulator.

� Stores the result of the addition to D2. The accumulator still contains the value 15.

Tab. 3-6: Key to figure above



Calling Function Blocks

Function blocks can only be called as instances, using the following operators:

CAL (Call)
CALC (CallConditional))
CALCN (CallConditionalNot)

CAL is always executed. CALC and CALCN first poll the status of the bit accumulator; they are
executed only if its value is 1 (CALC) or 0 (CALCN).

The instance name is assigned in the header of the POU. The actual parameters must then be
passed to the formal parameters in the code programmed in the body.
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Fig. 3-12:
The formal parameters
of function block
POU_9 are "IN" and
"OUT". Actual
parameters "TimerS1"
and "ComeIn" are
passed to these formal
parameters.�

�

�

Number Description

� Declares the instance "Reset" of function block POU_9.

� There are two ways to pass actual parameters to formal parameters.

� There are two ways to pass actual parameters to formal parameters.

Tab. 3-7: Key to figure above



Calling Functions

When you call a function, you must pass the necessary actual parameters to its formal param-
eters.

A total of n - 1 actual parameters are assigned to every function, where n = total number of
function parameters.This is because the first parameter must always be written to the bit accu-
mulator with the LD instruction.

Example

The "Average" function is programmed to perform the following operation:
(D0 + D1 + D2 + D3) : 4.

When the function has been executed the bit accumulator contains the resulting average value
of the four input parameters.

�
LD must also be used to pass the first parameter for the EN/ENO functions
(e.g. E_ADD, E_MUL, E_XOR). Their first parameter is always the Boolean EN input
(EN = ENable).

Example

The "E_ADD" function performs the following operation: D0 + D1 = D2.

Following execution of this function the bit accumulator will contain the status of the ENO
output (ENO = ENable Out), which in term has the same status as the EN input.

�
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Fig. 3-13:
Use of "Average", a function written by the user in IEC IL
language. The function has 4 input parameters.

Fig. 3-14:
This writes actual parameter X0 to the EN input. The 3
parameters for execution of the addition are programmed
with the function itself.



3.7.3 The Graphical Editors

The Ladder Diagram Language (LD)

You can use all available programming instructions in the ladder diagram language
(see Appendix in Reference Manual).

Ladder diagrams consist of contacts (break and make contacts), coils, function blocks and
functions. These elements are linked with horizontal and vertical lines, referred to as intercon-
nects. These interconnects always begin at the power bar on the left, which is sometimes also
referred to as the rail.

NOTE Each network can contain no more than one contiguous circuit unit.

The functions and function blocks are displayed as shaded blocks in the editing window.
In addition to their input and output parameters, some also have a Boolean input
(EN = ENable) and a Boolean output (ENO = ENable Out).
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Fig. 3-15:
Graphical programming in the
ladder diagram editor

�
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Number Description

Network bar

Power bar

Input variable

Output variable

EN input

ENO output

Output variable

Contact

Coil

Comment

Tab. 3-8: Key to figure above



Calling Function Blocks

Function blocks can only be called as instances. The instance name must be declared in the
header of the POU.

In the ladder diagram editor, the name of the function block is displayed inside the shaded
block. The instance name declared in the header must be entered directly above the block.
Then the actual parameters must be passed from outside to the formal parameters shown
inside the block.
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Fig. 3-16:
Calling function blocks�

�




�

Number Description

� Declaration of "Reset", an instance of function block POU_9.

�
Activation of function block POU_9. The word "Instance" above the shaded block indicates that
you must enter the function block's instance name here.


 The instance name "Reset" has been entered.

�
Next, the actual parameters "TimerS1" and "ComeIn" are passed to the formal parameters
"IN" and "OUT".

Tab. 3-9: Key to figure above



The Function Block Diagram Language (FBD)

In the function block diagram language you can also use all programming instructions (see
Appendix in Reference Manual). They are displayed as shaded blocks which are connected
with the horizontal and vertical interconnect lines. Power bars are not used in this language.

In addition to the normal input and output parameters some blocks also have a Boolean input
(EN = ENable) and a Boolean output (ENO = ENable Out).

Calling Function Blocks and Functions

In the function block language, function blocks and functions are called in exactly the same
way as in the ladder diagram language.
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Fig. 3-17:
Graphical programming in the
function block language editor
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Number Description

� Network bar

� Input variable (normal)


 Input variable (negation)

� Function

� EN input

� ENO output

� Output variable

Tab. 3-10: Key to figure above



The Sequential Function Chart Language (SFC)

SFC is a structuring language which allows clear representation of complex processes.

NOTE The program is the only available program organisation unit (POU) in this language.

The basic elements of the SFC language are steps and transitions.
From 0 to n actions can be assigned to each step.An action can be a Boolean variable (output
or relay) or a PLC program. These programs can be written using any of the editors - including
the Sequential Function Chart language itself. All actions are listed in the Action_Pool in the
Project Navigator window.
Each transition is assigned a transition condition.Transition conditions can be written using
any of the editors - except Sequential Function Chart itself. All transitions are also listed in the
Project Navigator window. Transitions pass control to the next step in the program sequence
when their condition evaluates as logical true.

Assignment of actions to steps and of transition conditions to transitions is performed with the
following toolbar icons:
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Fig. 3-18:
Sample SFC project�

�




�

�

Number Description

� The "P_Payment" program organisation unit, which is declared as a program [PRG].

� The header contains the POU's variables.


 The PLC program was written with the SFC editor.

� The individual transitions can be written with different editors.

� The Action Pool contains the individual actions, which can also be written in different editors.

Tab. 3-11: Key to figure above

Fig. 3-19:
Activate action/transition condition

Fig. 3-20:
Deactivate action/transition condition



Sequencing Rules

A sequence always begins with an Initial Step, identified by a double outline. The initial step
does not have to be at the physical beginning of the sequence, it can also be placed in other
locations.

Steps are displayed as shaded blocks with names. Transitions are shown as small boxes
placed directly on the vertical connecting lines between the steps.

Only one step can be active at any one time; this also applies in sequences with selective
branching. A step is activated when the directly preceding step is deactivated and the transi-
tion condition (i.e. the continue condition) is satisfied. If the continue conditions of two or more
transitions are fulfilled at the same time in a sequence with selective branching, execution pri-
ority is defined by the order of the sequences from left to right. This means that only the
sequence that is furthest to the left will be executed.Even if their continue conditions are satis-
fied, the sequences further to the right will not be executed.

Sequences can also contain left and right "divergences" and "convergences" (i.e. alternative
branches for different transition conditions). These branches are identified by a double hori-
zontal interconnect lines.

Jumps are also allowed within sequences. These are effected with exit points (jump instruc-
tions) and entry points (labels).

Every step can be declared as a macro step, consisting in turn of a sequence.Macro steps are
identified by two additional horizontal lines within the block. The only limitation on the nesting
depth is the memory capacity of the controller.

NOTE You will find more detailed information on the sequencing rules of the SFC language in the
Reference Manual.
You can find a detailed example in Chapter 6 of this manual (Step 6).
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Fig. 3-21:
Graphical programming in the
Sequential Function Chart editor
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Number Description

� Initial step

� Step


 Transition

� Jump exit point

� Jump entry point

� Final step

Tab. 3-12: Key to figure above



4 Installation

4.1 Hardware Requirements

4.1.1 Recommended Hardware Configuration

� Pentium II 350 processor or above

� 32 MB RAM (Microsoft Windows 98/Me)
64 MB RAM (Microsoft Windows NT/2000/XP)

� Serial interface (RS-232)

� Hard disk with at least 100 MB free

� CD-ROM drive

� 17" (43 cm) VGA monitor (1024 x 768 pixels)

4.1.2 Software Requirements

GX IEC Developer is a 32-bit product. The following operating systems are supported:

� Microsoft Windows version 98/Me (with all detailed versions e. g. ServicePack 1)

� Microsoft Windows NT Workstation 4.0 (with all detailed versions e.g. ServicePack 6)

� Microsoft Windows 2000 Professional (with all detailed versions e.g. ServicePack 2)

� Microsoft Windows XP Professional (with all detailed versions)

� Microsoft Windows XP Home Edition (with all detailed versions)

Versions of Microsoft Windows which are based on double-byte character sets (e. g. Japa-
nese) are not supported.

4.2 Copyright

E
WARNING:
This software is protected by copyright. By opening the distribution disks package you
automatically accept the terms and conditions of the License Agreement. You are only
permitted to make one single copy of the original distribution CD-ROM for your own
backup and archiving purposes.
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4.3 Installing GX IEC Developer

During this procedure the installation program will create a directory on your hard disk, into
which all the GX IEC Developer files will be copied.

4.3.1 Installing GX IEC Developer on your hard disk

� Make sure that the correct Microsoft Windows version is properly installed on your computer.
For information on using Microsoft Windows please refer to the Windows User's Guide.

� Start Microsoft Windows.

� Insert the installation CD-ROM in the CD-ROM drive.
The GX IEC Developer installation program starts automatically
(if not, execute the file SETUP.EXE on the installation CD-ROM).

� Follow the instructions that appear on the screen.

� Enter the user name, company name, and serial number of the software.

� Follow the instructions that appear on the screen.

� When the installation procedure is finished the program will create a new program group in
the Start menu containing the GX IEC Developer program icon.

For further details on the necessary Microsoft Windows procedures please refer to your
Microsoft Windows documentation.

4.3.2 Starting GX IEC Developer

� In the Start menu click on the GX IEC Developer program icon. The icon is located in:
Start > Programs > MELSOFT Application > GX IEC Developer. This starts GX IEC De-
veloper and displays the start-up screen.

� Confirm with the� key.

4.3.3 Quitting GX IEC Developer

You can quit GX IEC Developer directly at any point in the program by pressing the key combi-
nation��.

Or:

Double-click on the Quit command in the Project menu.
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5 The User Interface

5.1 The Elements of the User Interface

The Project Navigator window and the complete menu bar are both only displayed after open-
ing an existing project or creating a new one (see Step1 in chapter 6 "Getting Started"). The
illustration below shows a variety of different windows: The Project Navigator, PLC Parameter
and the Header and Body windows of a POU. You can resize and arrange the windows on the
screen to suit your individual preferences.
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Fig. 5-1: User interface
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Item Description

� Application title bar

� Menu bar


 Toolbar

� Dialogue box

� Button

� Declaration table (header)

� Object window

� Vertical scrollbar

� Editor (body)

� "Maximise" button

� "Minimise" button

� Status bar

� Horizontal scrollbar

� Project Navigator window

Tab. 5-1: Key to figure above



5.1.1 The Menu Bar

The GX IEC Developer menu bar uses the standard Windows procedures. When you select
one of the menu titles in the menu bar, a drop-down list of available commands is displayed.
Commands with an arrow symbol open a submenu of additional commands. Selecting a com-
mand opens a dialogue or data entry box. The menu structure and the available options are
context-sensitive, changing depending on what you are currently doing in the program.
Options displayed in light grey are not currently available for selection.

NOTE A list of all menu commands with explanations is provided in the Appendix of the Reference
Manual.

5.1.2 The Toolbar

The toolbar enables you to select the most important menu commands directly by clicking on
the corresponding icons. The toolbar is context-sensitive, i.e. different tool icons are displayed
depending on what you are currently doing in GX IEC Developer.

NOTE A complete list of all the available tools and icons is provided at the end of the Reference
Manual.

5.1.3 Windows

GX IEC Developer allows you to edit multiple objects at the same time (e.g.body, header, task).A
window is opened on the screen for each object.You can change the size and position of the win-
dows on the screen as you wish.Objects often contain more information than can be displayed in
the window; when this happens, horizontal and vertical scroll bars are included that can be used
to "scroll" the contents of the windows up and down and from side to side.

5.1.4 The Status Bar

The status bar at the bottom of the screen is used to display information on the current status of
your project.You can disable the status bar if you wish, and you can also configure the informa-
tion to be displayed to suit your needs.
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5.1.5 The Project Navigator

The Project Navigator is the "control centre" used for selecting and handling the objects used
in GX IEC Developer. This is the starting place for all operations performed on GX IEC Devel-
oper objects. The Project Navigator window is not displayed until you open a project. Closing
the Project Navigator window automatically closes the project currently on screen.

Using the Project Navigator

In the Project Navigator tree you can expand a branch by clicking on its [+] symbol and col-
lapse a branch by clicking on its [–] symbol. Expanded and collapsed branches are identified
by different symbols [–] or [+] in the tree. You can also expand or collapse branches by
double-clicking on the appropriate branch icons. Double-clicking on the lowest level opens the
window of the object on that level.

You can only perform the Cut, Copy, Paste and Delete operations on POU and Task objects.You
can copy and delete multiple objects at the same time. To select individual multiple objects, hold
down the CTRL key and click on the objects one after the other with the left mouse button. To
select a consecutive group of multiple objects, first select the first object with a single click, then
hold down the SHIFT key and click on the last object in the list you want to select.

NOTE The Extended Information command in the View menu enables or disables the display of
additional information with the items in the Project Navigator window.

Project Navigator views

Three different views can be selected for the Project Navigator via tabs below the Project Navi-
gator window:

Project

This view gives a total overview of the project. It contains all elements of the project.

Calltree

For this view, the corresponding root items are tasks or also POUs, if they are not related to a
specific task. As subitems all used POUs are shown. Additionally, it can be defined per object,
if used global variables should also be shown.

Used by

This view has exactly two root items. The first root item is the POU pool with its POUs as nodes.
Subitems of the POUs and global variables are always POUs calling respectively using the cor-
responding POU or global variable.
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5.2 Declaration Tables

The local variables of program organisation units (POU Header) and global variables are
defined in declaration tables.

Working with tables

You can access every cell in a table directly by clicking with the mouse. When the insertion
mark (cursor) appears you are in editing mode and can make entries. You can move around in
tables with the following keys and key combinations:

Key Movement

� Line up
� Cell right
� Line down
� Cell left
	 Step through all cells from left to right

	 Step through all cells from right to left

� Insert new line

You can also add new lines to a table with the New Declaration command from the Edit menu.
You can insert a new line at the beginning, end of the table or before or after the current line.

Deleting Tables and Lines

Clicking on one of the shaded line number boxes at the left selects the corresponding line.
Clicking on the empty uppermost box in the number box column selects the entire table. You
can then delete the selected line or table by pressing the DEL key.

NOTE The program performs these delete operations immediately, without prompting for
confirmation. If you inadvertently delete something you can recover it by selecting the Undo
command in the Edit menu. Undo only works if you select it directly after the delete
operation, however!

Formatting Tables

You can adjust the width of the table columns to suit your individual needs. Move the mouse
pointer to the dividing line between the shaded column title boxes, so that the pointer changes
to a double-headed arrow. Then press and hold the left mouse button and drag the shaded
dividing line until the column has the desired width.
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5.3 The Editors

Your PLC programs are always divided into a number of logical program sections - referred to
as "networks". These networks can be assigned names (labels) which can then be used as
jump destinations within the PLC program. New networks are inserted with the New Network
command in the Edit menu.

To open an editing window, simply double-click on a Body entry in the Project Navigator window.

Text Editors

� IEC Instruction List

� MELSEC Instruction List

� Structured Text

Graphical Editors

� Ladder Diagram

� Function Block Diagram

� Sequential Function Chart
Please refer to the Reference Manual for full details on using the SFC language.

5.3.1 Using the text editors

All cursor movements and editing functions are similar to those of a standard word processor.
The following additional conventions also apply in the text editors:

� To activate editing mode, click on the surface of a network with the mouse pointer.

� Each program line contains one controller instruction, with the following syntax:
Operator TABSTOP Operand(s)

� The operator and the operands must always be separated by tabstops.

� Pressing F2 when the cursor is in the first column displays a list of available programming
instructions; pressing it in the second column displays a list of available operands
(variables).

� You can also enter optional comments, which can be one or more lines long. Comments
must be enclosed between (* and *) characters.

� You can move around in the program lines with the normal cursor keys.
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5.3.2 Using the graphical editors

Working in the graphical editors is similar to using a drawing program.You can add elements to
the networks in the editing windows by selecting symbols in the toolbar and with the com-
mands in the Tools menu. The following elements are available:

� Contact (input, LD only)

� Coil (output, LD only)

� Programming instructions

� Input variable

� Output variable

� Return instruction

� Jump label

� Comment

Once you have positioned the elements, you then connect them with one another using inter-
connect lines.

NOTE In Chapter 6 (Step 6) you will learn how to use the different editors
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6 Getting Started

This chapter contains an introductory outline of all the steps required to create a new project
with GX IEC Developer, with clear instructions on the procedures necessary in each step.

Steps Page

Step 1 Creating New Projects 6-2

Step 2 Creating Tasks 6-4

Step 3 Declaring Global Variables 6-5

Step 4 Creating Program Organisation Units 6-7

Step 5 Programming POU Headers 6-8

Step 6 Programming POU Bodies 6-9

Programming examples: � Inputs and outputs in LD
� Sum function in FBD
� I/O signal configuration parameters
� Timers in LD/FBD/IL
� Sequential Function Chart language

Step 7 Checking PLC Programs (syntax check) 6-36

Step 8 Configuring Tasks 6-37

Step 9 Compiling Projects 6-39

Step 10 Communications Port Setup 6-40

Step 11 Downloading Programs to the PLC 6-41

Step 12 Monitoring Programs 6-42

Step 13 Uploading Data from the PLC 6-43
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6.1 Step 1: Creating New Projects

How to create a new project

� Select New in the Project menu.

� This displays the Select PLC Type dialogue box. Select your PLC in the PLC Type field
and confirm your selection with OK.

� The New Project dialogue box is displayed.Select or enter the path under which you wish to
store the new project.

� Enter a name for the new project at the end of the path (the project name is also the name
of the subdirectory/folder in which it is stored). When you are satisfied, click on the Create
button to create the project.
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Fig. 6-1
CPU type selection

Fig. 6-2:
In this example a project called
PROJ_NEW is being created in the
subdirectory D:\PROJECTS.
Please note that PROJ_NEW is not a
single file, but rather a subdirectory created
by GX IEC Developer to contain all the
project files.



� In the dialogue box GX IEC Developer New Project Startup Options click on the Empty
Project option button and confirm with OK.

As soon as you have created a new project the Project Navigator window is displayed on the
screen automatically with all the standard entries for the project.

The project entries are displayed in a hierarchical tree structure, which always contains the fol-
lowing standard components:

– Project Name

– Library Pool

– PLC Parameters

– Task Pool

– Data Unit Types Pool

– Global Variables

– Program Organisation Units

Additional information is displayed in brackets after each entry in the Project Navigator window.
You can disable the display of these details by clicking on Extended Information in the View
menu (a ✓ check mark is displayed next to the option when it is enabled).

The standard GX IEC Developer window background colour is light grey. You can change all
the colours to suit your personal taste with Colors in the View menu.
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Fig. 6-3:
Project Navigator showing standard
entries for the project

Fig. 6-4: GX IEC Developer then creates the empty
new project as defined.



6.2 Step 2: Creating Tasks

How to define a new task

� Select the Project Navigator window.

� Select New in the Object menu, then select the Task option.

Or

Click on the New Task icon in the toolbar:

NOTE This tool icon is only displayed in the toolbar when the Project Navigator window is displayed
on the screen, i.e. when a project is open.

The New Task dialogue box is displayed.

� Enter a name (max. 32 characters) for the new task and confirm with OK. GX IEC Developer
then creates the task and displays the name in the Task Pool in the Project Navigator window.

NOTE Assignment of the program organisation units (POUs) to the tasks and definition of the task
attributes will be performed later on in Step 8.
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Fig. 6-5:
Defining a new task



6.3 Step 3: Declaring Global Variables

How to declare global variables

� Double-click on the Global_Vars branch in the Project Navigator. This opens the Global
Variable List window on the right hand side of the screen, containing the declaration table
for entry of the variables.

� Click in the first cell in the Class column with the mouse cursor, then click on the up arrow
button and select VAR_GLOBAL or VAR_GLOBAL_CONSTANT.

� Press	 to move to the Identifier column, then enter the identifier for your first global variable.

� Press	 to move to the MIT-Addr. or IEC-Addr. column.Enter the absolute address of the
global variable.

� Press 	 to move to the Type column and click on the up arrow button with the mouse to
open the Type Selection dialogue box.

� Select Simple Types in the Type Class field.

� Select the appropriate data type from the list on the left.

The initial value in the Initial column is assigned automatically and cannot be changed by the user.

� Press	 to move to the Autoextern column, and click on the row of the variable you want to
apply this function to.

The function Autoextern writes the corresponding variable to all headers and all new POUs.

� If you want to enter a comment text for the variable press	 to move to the Comment co-
lumn, then enter your text.
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Fig. 6-6: Declaration table of Global Variable List

Fig. 6-7:
Data type selection



� To enter another variable,

– If the editing cursor is active in the Comment column (white background with blinking
cursor), you can create a new variable declaration line by pressing	.

or

– Select any cell in the last line of the table and press
�.

or

– Select New Declaration in the Edit menu and then select the position in which it is to
be inserted from the submenu.

or

– Copy an existing declaration line: First select the line by clicking on its number button at
the left, then press �� to copy it to the clipboard.Then select the insertion position by
clicking on the appropriate number button and press �
 to insert.

 Save your new entries with Object - Save.

NOTE The terms identifier, address and data type are defined and explained in Chapter 3.
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Fig. 6-8:
Entering another variable

Fig. 6-9: Entering another variable



6.4 Step 4: Creating Program Organisation Units

Program organisation units (POUs) always consist of two main parts, a header and a body.

How to create a new program organisation unit

� Click on the New POU icon in the toolbar:

NOTE This tool icon is only displayed in the toolbar when the Project Navigator window is displayed
on the screen, i.e. when a project is open.

� Enter a name for the new POU and specify whether it is to be created as a program (PRG),
a function (FUN) or a function block (FB). Then select the programming language/editor to be
used for the creation of the PLC program in the POU's body. When you are satisfied that all
your entries are correct select OK to add the new POU to the project.

The new "Control" POU is then added to the project and appears in the POU Pool in the
Project Navigator window.

� Double-click on "Control" to open the subordinate entries.
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Fig. 6-10:
A new POU called "Control" is being defined and
declared as a "Program" (PRG) type.

The PLC program in the body of the POU
is going to be written in ladder diagram language.

Fig. 6-11:
The [+] symbol to the left of "Control" in the project tree
indicates that this entry has subordinate entries that are
currently collapsed. The asterisk in front of the term "Control"
indicates that this POU has not yet been compiled.

Fig. 6-12:
Every POU has two main components: a header and a body
containing the actual program in the selected programming
language.



6.5 Step 5: Programming POU Headers

The POU header is used to declare and store the variables used by the program that the POU
contains. In addition to global and local variables, these declarations can also include instances
of function blocks.

How to program the POU header

� Check that the Header and Body entries are displayed under the POU entry in the
POU Pool and expand them if necessary (see � in Step 4).

� Double-click on the "Header" entry in the Project Navigator window. This opens a window
containing the declaration table for the header's local variables on the right hand side of
the screen.

� To declare the variables, proceed in exactly the same way as with the global variables in Step
3 above, entering the class, identifier and data type for each variable.

� Select Save in the Object menu to store your entries

NOTE If you wish to enter global variables in the header you can copy them from the global
variables declaration table (��) and then insert them in this declaration table (��).

The terms class, identifier and data type are defined and explained in Chapter 3.
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Fig. 6-13: Declaring variables for the program header



6.6 Step 6: Programming POU Bodies

The body contains the actual code of the PLC program. The programming language used is
shown in the information in brackets following the "Body" entry in the project tree.

How to program the POU body

� Check that the Header and Body entries are displayed under the POU entry in the
POU Pool and expand them if necessary (see � in Step 4).

� Double-click on the "Body" entry in the Project Navigator. The editing window of the editor
for the selected programming language is opened on the right hand side of the screen.
It contains one network.

If you wish, you can disable the background grid display by clicking on Grid in the View menu
(a ✓ check mark is displayed in the menu when the function is enabled).
You can adjust the size of the background grid with the Environment option in the View menu.
Please note that the value you enter for the grid spacing changes the setting for the entire
screen setup, and not just for the selected programming editor.

� Now you can start writing your PLC program.

You will find programming examples for the various programming languages and editors
on the following pages.

� Select Save in the Object menu to save the body of your POU.

NOTE You can increase the size of the editing area with the mouse. Position the mouse pointer on
the lower edge of the network bar box at the left of the editing window (the pointer changes to
a double arrow when it is over the resize line). To resize the editing area, hold down the left
mouse button, drag the dotted line to the desired position and then release the button.
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Fig. 6-14:
Programming a POU body in a network
editor



6.7 Programming Examples

6.7.1 Inputs and outputs in ladder diagram language (LD)

Programming inputs and outputs in the LD editor

� In the Project Navigator window, double-click on a program body entry defined with the
ladder diagram language (LD).

� Click on the “Contact” tool icon in the toolbar.

� Move the mouse pointer to the desired position and press the left mouse button to place the
input contact.

� Click on the “Coil” tool icon in the toolbar.

� Move the mouse pointer to the desired position and press the left mouse button to place the
output coil.
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Fig. 6-15:
Placing the input contact

Fig. 6-16:
Selecting the "Coil" tool

Fig. 6-17:
Placing the output coil

Fig. 6-18:
Selecting the "Contact" tool



� Click on the"Interconnect/Line" tool icon in the toolbar

or

Click with the right mouse button to open the context menu. Select the option “Line”.

� Position the pointer over the left network bar and click the left mouse button. Draw a line to
the connection point of the output coil and left-click again.

The "?" character that appears above the input contact and output coil symbols serves as dummy,
which you must replace with declared operand names or a direct address (X, Y).

� Click on the "Select mode" tool icon in the toolbar. Using the mouse pointer, select the "?"
dummy character over the contact and the coil and overwrite the dummy character with ap-
propriate variable names.Alternatively, you can also press� to display the operand selecti-
on list and select a name from the list.

NOTE For the described procedures the Auto Connect mode is not activated.
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Fig. 6-19:
Selecting the "Selection" tool

Fig. 6-20:
Drawing a connection line

Fig. 6-21:
Selecting the "Line" tool



6.7.2 A Sum Function in FBD Language

Programming a sum function in the FBD editor

Steps � through � below are exactly the same in the ladder diagram and function block dia-
gram editors. Only the tools displayed in the toolbar are different in each case.

� In the Project Navigator window, double-click on a body entry defined with the function
block diagram language (FBD).

� Click on the “Function Block” tool icon in the toolbar.

� Double-click on the ADD instruction in the selection box displayed.

� Position the mouse pointer and press the left mouse button to place the function block.
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Fig. 6-22:
Selecting the "ADD" instruction

Fig. 6-23:
Placing the function block

Fig. 6-24:
Selecting the
"Function Block" tool



� Click on the dummy character “?” of the input variable. Overwrite the first dummy character
with the number 12 and the second dummy character with the number 8.

� Click on the dummy character “?” of the output variable and then press� to display the ope-
rand list. Select "Sum" and confirm with OK.

NOTE The variables will only appear in the operand list if the header in which they are declared has
been saved.
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Fig. 6-25: Declared variables in the header must have been saved

Fig. 6-26:
Overwriting the
dummy character "?"



6.7.3 I/O Signal Configuration Parameters

Setting the signal configuration parameters of inputs and outputs

� Double-click on an input contact, an output coil or the connection point of a variable in
a function block to display the Signal Configuration dialogue box. Select the appropria-
te options, then confirm with OK.
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Number Description

� Negated input contact (LD only)

� Negated output coil (LD only)


 Set output coil (LD only)

� Reset output coil (LD only)

� Negated input variable (LD and FBD)

� Negated output variable (LD and FBD)

Tab. 6-1: Key to figure above

Fig. 6-27:
Signal configuration

�

	

�




�

�



6.7.4 Timers in LD/FBD/IL

Description of the timer device

All timers must have the following four elements:

TValue: Set point value
TN: Actual value
TC: Output coil
TS: Input contact

The timer example

The following example shows how to program a timer and a function block instance
(see Chapter 3) in ladder diagram, function block diagram and Instruction List languages.

Objective

When "Input1" is set the 100-ms timer "Timer1" must start to count and continue until it
reaches a value of 100. We want "Output1" to be set when "Input2" is set, and we want
"Output1" to be
reset again when the set point value of 100 is reached.

Algorithm:

"Input2" and the timer contact "Timer1S" (TS) are responsible for switching "Output1".
This function will be performed by the user-programmed function block SET_RST."

"Input1" activates the timer, i.e. it controls the switching of the timer coil "Timer1C" (TC).
The set point value TValue is 100. The timer function will be implemented by using the
manufacturer function TIMER_M.
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Fig. 6-28
The element TValue is passed to the function directly.

Fig. 6-29 The elements TN, TC and TS must be declared in the global variables list.



Creating the program

Step 1: Program the function block SET_RST

� Create a POU called "SET_RST" and define it as a function block to be programmed
in ladder diagram language (see Step 4).

� Enter the following three variables in the header: SET, RST and Q.

� Insert two network circuit blocks in the body.

Q is set when SET is active, and Q is reset when RST is set.
You can configure the S (set) and R (reset) parameters by double-clicking on the coil symbol.

� Save the header and the body (Object - Save).

� Select the "SET_RST" POU in the Project Navigator window and press��.The following
dialogue box is then displayed:

� Activate the EN/ENO Contacts check box to assign an EN input and an ENO output to the
function block and activate the Macrocode to create an optimized code.
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Fig. 6-30:
Function information

Fig. 6-31: SET and RST are input variables (VAR_INPUT).
Q is an output variable (VAR_OUTPUT).



Step 2: Define the global variables

The timer elements TC, TS and TN must first be declared in the Global Variable List. They can
then be called in the header of the POU in which the timer is going to be used. In this example,
the input and output variables are also declared globally.

� Open the global variable declaration table (see Step 3).

� Declare the following variables.

Step 3: Create the Timer POU (ladder diagram)

� Create a new POU as a program using the ladder diagram language (see Step 4).

� Open the header of the new POU and declare the following variables:

You can speed up this process by copying the variables that you have already entered in the
Global Variable List and inserting them here.
If the function Autoextern is activated, the variables have been copied here automatically.

Use global variables = VAR_EXTERNAL
Use as local variables = VAR
The variable SET_RST1 is an instance of the function block SET_RST (see Chapter 3 for
details on instancing).

� Save the header (Object - Save).
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Fig. 6-32: Declaring the global variables

Fig. 6-33: Declaring the variables in the header



� Open the body of the POU.
The timer we shall use is a function that is stored in the manufacturer library.

You can find instructions on how to insert function blocks in the editing window in the section on
”Sum Function in FBD”.

� Create the following PLC program:

The function blocks used in the program can be found in the following libraries:

Manufacturer Library: TIMER_M
Function blocks: SET_RST
IEC Standard Library: MOVE
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Fig. 6-34:
Ladder Diagram
program example

Fig. 6-35:
The timer function is called TIMER_M



Timer sequence

The timer sequence begins when INPUT1 is set and the timer starts to run. If INPUT2 is set,
OUTPUT1 is switched on.

When the 10-second period has elapsed, timer contact TIMER1S is set and OUTPUT1 is
switched off again.
If Input2 still remains set or is set, Output1 will be set again.

The lower program block containing the MOVE instruction is only necessary to make it possi-
ble to follow the 10-second sequence in monitoring mode.

Programming the timer in function block diagram language

The following illustration shows how to realize the same program using function block diagram
language:
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Fig. 6-36:
Function Block Diagram
program example

0

10

Fig. 6-37: Timer sequence

"Input1"

"Timer1C"

Timer runs for
10 seconds

"Timer1S"

"Input2"

"Output1"



Function block diagram language

Timer:
Coil: TIMER2C
Contact: TIMER2S
Actual value: TIMER2N

Programming the timer in Instruction List language

The following illustration shows how to realize the same program using Instruction List lan-
guage:

Instruction list language

Timer:
Coil: TIMER1C
Contact: TIMER1S
Actual value: TIMER1N

NOTE Please refer to Chapter 3 for detailed instructions on how to call functions and pass the actual
parameters to the formal parameters of function block instances in the Instruction List language.

6.7.5 Sequential Function Chart Language

You can find a basic introduction to the SFC programming language in Chapter 3 of this manual.
More detailed information is provided in the Reference Manual. The following example is a
step-by-step illustration of the procedures required to create an SFC program using the GX IEC
Developer tools.
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Fig. 6-38: Instruction List program example



The "Process" sample program

The program is called "Process" and solves the problem using a variety of selective branching
constructs and the Jump instruction.

Program execution

� When the PLC is switched to RUN mode "Output1" is set.

� The transition "TRAN_1" performs a TRUE/FALSE poll of "Input1". If "Input1" is set
"Step_1" and "Step_1_a" are both activated. "Output2" blinks and "Output3" is switched on
continuously.

� The transition "Input2" polls "Input2". If the latter is set "Step_2" is executed and "Output4"
is set.

� In the subsequent branches to "Input3", "Input4" and "Input5" a variety of program
sequences then execute in parallel.

If "Input3" is set, this activates "Step_3". "Input5" activates the jump exit point "Jump"
which leads to the jump entry point "Jump" and also activates "Step_3". "Step_3" sets
"Output5".

If "Input4" is set, this triggers "Step_4", which then switches "Output6".

� "Input6" and "Input7" lead to the end of the program.
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Fig. 6-39: The "Process" program



Creating the program

Perform steps 1 through 8 in the order described.

Step 1: Create the POU

� Create a new POU called "Process". Select PRG (program) as the class and Sequenti-
al Function Chart as the programming language (see Step 4).

In addition to the header and the body, each POU written in SFC language also has an action
pool entry in which the actions assigned to the POU are stored.

Step 2: Declare the variables in the header

� Open the header and enter the variables to be used in the POU (see Step 3).

NOTE The variables must also be declared in the GVL.

Step 3: Open the body

� Double-click on the "Body" entry in the Project Navigator window.
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Fig. 6-40:
The new "Process" POU is displayed in the Project Navigator.

Fig. 6-41:
In this example only global
variables are used. Global
variables are referenced by
using the VAR_EXTERNAL
class.

Fig. 6-42:
When you open the SFC editor the following
elements are displayed:
- The Initial Step (double outline)
- The transition TRUE
- The Final Step



NOTE Steps to which no actions are yet associated are shown filled in white.The fill colour changes
to grey when actions are associated. Your current position in the sequence is indicated by a
"block cursor", displayed as a black rectangle around the elements that can be moved
around at will in the editing window with the mouse or cursor keys.The tool icons activated in
the toolbar change depending on the current position of this cursor; you cannot use all the
tools at all positions in a program.

Step 4: Create the sequence

� Select the "TRUE" transition with the block cursor.

� Click on the tool icon

Inserts a new step and transition pair.

� Select the step you have just inserted.
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Fig. 6-43:
Selecting the "TRUE" transition

Fig. 6-44:
Inserted new step and transition pair

Fig. 6-45:
Selected new step



� Click on the tool icon

Inserts a right divergence and a new step.

� Select the "TRUE" transition.

� Click on the tool icon

Inserts a right convergence.
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Fig. 6-46:
Inserted new right divergence and step

Fig. 6-47:
Selected "TRUE" transition

Fig. 6-48:
Inserted new right convergence



� Select the "TRUE" transition.

� Click on the tool icon

Inserts a new step and transition pair.

� Select the "TRUE" transition.
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Fig. 6-49:
Inserted new step and transition pair

Fig. 6-50:
Selected "TRUE" transition

Fig. 6-51:
Selected "TRUE" transition



� Click twice on the tool icon

Inserts two right divergences with transitions.

 Select the "TRUE" transition.
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Fig. 6-52:
Two inserted new right divergences

Fig. 6-53:
Selected "TRUE" transition



! Click on the tool icon

Inserts a new step and transition pair.

" Click in the empty space next to the step you have just inserted.
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Fig. 6-54:
Selection rectangle for location of new
step and transition pair

Fig. 6-55:
Inserted new step and transition pair



# Click on the tool icon

Inserts a new step and transition pair.

$ Click on the final step.
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Fig. 6-56:
Selected final step

Fig. 6-57:
Inserted new step and transition pair



% Click on the tool icon

Inserts a right convergence.

& Click on the left hand step in the bottom row.
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Fig. 6-58:
Selected step in the bottom row

Fig. 6-59:
Inserted new right convergence



' Click on the tool icon

Inserts a jump entry point.

( Click on the empty space below the free transition.

6 – 30 MITSUBISHI ELECTRIC

Programming Examples Getting Started

Fig. 6-60:
Selected position for new item

Fig. 6-61:
Inserted jump entry point



) Click on the tool icon

Inserts a jump exit point.

Step 5: Assign names to the steps and the jump exit/entry labels.

� Double-click on the element you want to assign a name to. Activates editing mode.

� Enter the name (Example: "Step_1" through "Step_4" and "Jump").
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Fig. 6-62:
Assigned names to the steps and jump
exit/entry labels

Fig. 6-63:
Inserted jump exit point



Step 6: Assign transition conditions to the transitions

NOTE You can use transition programs, TRUE/FALSE and Boolean variables (referenced by direct
address or name) as transition conditions.

Assigning and creating a transition program

� Double-click on the transition to which you wish to assign a program.
Activates editing mode.

� Enter the program name (Example: "TRAN_1").

� Click on the tool icon

The New Transition dialogue box is displayed, with the program name you just entered.

� Select the programming language (Example: ladder diagram).

� Click on OK.
The body of the transition program is displayed automatically.

� Write the transition program.
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Fig. 6-64:
Entered program name

Fig. 6-65:
Programming language selection for transition

Fig. 6-66:
Transition program



Assigning an existing variable to a transition

� Double-click on the transition to which you wish to assign a variable.
Activates editing mode.

� Enter the name of an existing variable (Example: "Input2" to "Input7").

NOTE This overwrites the "TRUE" transition condition.
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Fig. 6-67:
Existing variables assigned to transitions



Step 7: Create the actions

� Select the "Process" POU in the Project Navigator.

� Click on the tool icon

Displays the New Action dialogue box.

� Enter a name for the action (Example: "Action_1") and select the programming language
(Example: ladder diagram).

The new action is displayed in the Action Pool in the Project Navigator window.

� Double-click on "Action_1" to open the program editor.

� Enter the program.

NOTE Transition and action programs are written in exactly the same way as any other POU. You
can write these programs using Instruction List, ladder diagram or function block diagram
language. The Sequential Function Chart language itself is not supported for these
programs, however.
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Fig. 6-68:
New action in the Action Pool in the Project Navigator

Fig. 6-69:
Action program

Fig. 6-70:
Programming language selection for action



Step 8: Assign actions or Boolean variables to the steps

� Select the step to which you wish to assign an action or variable (Example: "Step_1").

� Click on the tool icon

This displays the Action Association dialogue box, which is still empty.

� Press the � key.
This displays the Action Name List box showing the actions and Boolean variables that are
currently available.

� Select the appropriate action/variable (Example:
"Initial" = "Output1"
"Step_1" = "Action_1"
"Step_1_a" = "Output3"
"Step_2" = "Output4"
"Step_3" = "Output5"
"Step_4" = "Output6"
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Fig. 6-71:
Action Name List

Fig. 6-72:
Opened Action Association
dialogue box



� Close the Action Name List box by double-clicking on the control menu button.
The step will now be displayed with a grey fill colour.

6.8 Step 7: Checking PLC Programs (syntax check)

How to check your program for syntax errors

� Select the object to be checked in the Project Navigator window.

� Select Check in the Object menu

or

Click on the Syntax Check tool icon in the toolbar:

If the syntax check program finds any errors they are displayed and explained in the
Compile/Check Messages box.

� You can display the source of any errors found automatically:Double-click on the correspon-
ding error message in the Errors/Warnings list, or select the message and click on the Show
button. This calls the object containing the error, with the source of the error highlighted in
red.

NOTE You can perform syntax checks both on individual objects and the entire project as a whole.
You can also perform separate checks on the header and body of a single POU. Simply
select the object to be checked in the Project Navigator (to check the entire project select the
Project entry at the top of the tree).
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Fig. 6-73:
Errors are displayed and
explained in the
Compile/Check Messages box

Fig. 6-74:
Fill colour indicates assigned actions or
Boolean variables to the steps



6.9 Step 8: Configuring Tasks

In this section it is assumed that you have already created the tasks for your project
(see Step2). Their entries are displayed in the Task Pool in the Project Navigator tree. Before
you can use them in the program you must first specify the POUs you want to use in the tasks
and configure the task attributes.

How to assign PRG type POUs to tasks

� Double-click on the task's entry in the Task Pool. A table is displayed on the right of the
screen in which you can then assemble the task by specifying the POUs it is to contain.

� Click on the pop-up list icon in the first table line and select the POU you want to add to the
task in the dialogue box displayed. Confirm your selection with OK. Only POUs defined as
programs (PRG) are included in the dialogue box list. The name of the selected POU will
then appear in the POU Name column in the first line of the table.

NOTE Only POUs that have not yet been included in a previously stored task are included in the
dialogue box list.

Using the	 key, move the cursor to the next cell of the table and enter a comment for the POU
entry in the Comment column (optional).

Repeat step 2 for each additional POU you wish to use in the task. To insert a new table line for
the next POU entry, select New Declaration in the Edit menu, then select the position at which
the line is to be inserted in the submenu.

When the cursor is on a comment cell that is currently in edit mode (white background) you can
insert a new line at the end of the table automatically by pressing	.
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Fig. 6-75:
The task configuration table



How to configure the task execution attributes

� Select the task to be configured in the Project Navigator window or in the task configu-
ration table (select the grey number button in the first table column).

� Press�� to open the Task Information dialogue box.

The parameters in this dialogue box set the execution conditions and the security level for the
current task. Tasks can be either event-triggered or interval-triggered. Full details on the vari-
ous execution options can be found in the Reference Manual.

The dialogue box also shows the current size of the task and the date and time of the last edit-
ing change.

NOTE Please refer to the Reference Manual for details on configuration of the read/write access
parameters.
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Fig. 6-76:
Event = TRUE
(execute always)

Interval = 0
(because event-triggered)

Priority = 0
(maximum priority)

Priority = 31
(lowest priority)



6.10 Step 9: Compiling Projects

When you compile a project the system translates the program code into executable form to
prepare it for downloading to the controller CPU.

How to compile a project

� Select Rebuild all in the Project menu.

The progress of the compilation process and any errors found are documented in a status
window.

E
WARNING:
Compilation does not download the program code to the CPU, this must be done
separately!
Always perform a syntax check on the entire project before attempting to compile it
(Step 7).
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Fig. 6-77:
Errors are displayed and
explained in the
Compile/Check Messages
box



6.11 Step 10: Communications Port Setup

Before you can download a project to the PLC you must first configure the communications
port you are going to use for this purpose.

NOTE Before you begin, make sure that you know precisely which physical interface on your
personal computer is going to be used for transferring the data to the PLC system.

How to select and configure the communications port

� In the Online menu select Transfer Setup, then select Ports.
The Connection Setup dialogue box appears.

� Under PLC side I/F click on the button Seriell/USB.

� Select either USB or RS-232C. The COM-ports COM1–COM10 can be selected.

� Confirm the entries in the dialogue boxes with OK.

6 – 40 MITSUBISHI ELECTRIC

Step 10: Communications Port Setup Getting Started

Fig. 6-78:
PC side I/F
Serial setting

Fig. 6-79: Interface selection in the Connection Setup



6.12 Step 11: Downloading Programs (to PLC)

When your program project is complete and has been checked for errors and successfully
compiled you can download it to the controller system for execution.

Connecting the PLC system

� Connect the PLC to your personal computer.

� Make sure that you plug the connection cable into the same port on the computer that you
defined in the settings described in Step 10 above.

NOTE Please refer to the Reference Manual for details on the various different options available for
connecting the PC and PLC systems.

How to download a program to the PLC

� Select Transfer Setup in the Online menu, then select Project.
The Download Setup dialogue box is displayed on the screen.

� Click on PLC Parameter and Program, then confirm with OK.

E
WARNING:
You must always download the PLC parameter when you transfer a program to the PLC
for the first time! Q/QnA series PLCs must be formatted first.

� Select Transfer in the Project menu, then select Download to PLC to start the download.
The transfer process is documented in a list box; if no error messages are displayed the
transfer has been completed successfully.
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Fig. 6-80:
The Transfer Setup dialogue box options are used to
specify which data are downloaded to the PLC.



6.13 Step 12: Monitoring Programs

In monitoring mode, GX IEC Developer can display the current status and changes of the vari-
ables/devices used by your program.

NOTE You can only monitor error-free programs that have been compiled and downloaded to the
PLC system for execution.

� Select Monitoring Mode in the Online menu. A check mark ✓ in front of the option in
the menu indicates that the mode is currently active, and the entries in the Project Na-
vigator window switch to light grey.

� Open the body of the POU that you wish to monitor.

� Select Start Monitoring in the Online menu.

NOTE The PLC must be in RUN mode for monitoring to be possible.

The following examples illustrate how the status changes of the variables are displayed in
monitoring mode for the various programming languages supported by GX IEC Developer.

NOTE More detailed information on the display options and other monitoring mode features can be
found in the Reference Manual (Chapter 8).
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Fig. 6-81:
Function block diagram
Filled rectangle: Binary ON
Rectangle: Binary OFF
DATA = 40: 40 seconds have elapsed

Fig. 6-82:
Ladder diagram
Filled field between the input contacts:
ON
Filled rectangle: Binary ON
Rectangle: Binary OFF
DATA =100: 100 seconds have elapsed

Fig. 6-83:
Instruction list
ON/OFF status is
indicated by filled /not
filled
rectangles.



6.14 Step 13: Uploading Data from the CPU

How to upload data from the PLC's CPU to GX IEC Developer

� Select Transfer in the Project menu, then select the Upload from PLC option.

� This displays the PLC Parameter dialogue box.Select the appropriate CPU Type and con-
firm with OK (see Step 1).

� In the next dialogue box GX IEC Developer asks you to specify the path and name for the
uploaded project data, which will be stored as a new project.
If you want to create a new project for the upload follow the instructions in Step 1.
If a project is already open you can abort the procedure by clicking on the Cancel button.

� Click on Setup in the Transfer Setup dialogue box.

� This displays the Transfer Setup (CPU port) dialogue box. Select the correct port for your
system configuration (see Step 10).

� Confirm your entries in both dialogue boxes with OK.
This starts the upload procedure. Progress and any errors are documented in a list box.
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7 Sample Program: CarPark
NOTE This sample program is only intended as an illustration of programming and program

structure techniques in GX IEC Developer. In its present version it cannot be used as a basis
for producing your own executable programs. The sample version has been written for a
MELSEC FX series controller.

Description

The roll-up door of a car park building can be opened from inside and outside with a key-oper-
ated switch.Safety functions included in the program ensure that the door opens automatically
in the event of an alarm, and that it does not remain open for too long when no cars are entering
or leaving the car park. The program also keeps track of the number of cars in the building.

7.1 Project Structure

7.1.1 The Task "Main"

... always runs in the background, with maximum priority. This task contains the POUs "Con-
trol" and "Counter", which perform the following functions:

POU "Control"

– Car park status check

– Close car park door if no car drives in or out within a 60-second period

– Open car park door when an alarm is triggered

POU "Counter"

– Count the cars
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Fig. 7-1:
Project structure

Task:
MAIN

POU:
Counter

POU:
Control

CPark_OK

POU:
Door_
Control

Task:
Door_Operate

TRUE



7.1.2 The Task "Door_Operate"

... is event-triggered. It is activated when the OK signal for the car park door (variable:
CPark_OK) is set. This task contains the POU "Door_Control", which handles the following
functions:

POU "Door_Control"

– Open car park door when the key switches inside and outside the car park are operated.

– Open car park door when an alarm is triggered

NOTES GX IEC Developer allows you to apply an engineering design approach to project planning
and programming.This is illustrated in the "CarPark" project.Steps S1 through S11 are fully
documented.

In the sample program all the variables are already known and declared at the outset.
Of course, this ideal situation is not always possible in actual projects; one often has to make
corrections and add and delete variables in the course of the programming work. This
flexible approach is fully supported in GX IEC Developer; the system allows you to edit, add
and delete variable declarations at any time, both during programming and afterwards.

7.2 Create the new "CarPark" project (Step 1)

The first step is to create a new project. Refer to the instructions in S1 and enter "CarPark" as
the project name in step �.

7.3 Create the tasks (Step 2)

Create the "Main" and "Door_Operate" tasks.

7.4 Declare the global variables (Step 3)

Declare the global variables shown in the table below. The entries in the Comment column are
optional.
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7.5 Create the program organisation units (Step 4)

Create the three program organisation units: "Control", "Counter" and "Door_Control".Define all
three POUs as programs (PRG) and specify ladder diagram (LD) as the programming language.

Each POU consists of a header and a body. The header contains the declarations of the vari-
ables used by the POU, the body contains the actual PLC program code.

7.5.1 Project Navigator Window

All the tasks and POUs you create are automatically displayed in the Project Navigator window.
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Fig. 7-2
Tasks:

"Door_Operate"
"Main"

POUs:
"Control"
"Counter"
"Door_Control"

Fig. 7-3: Global Variable List



7.6 Program the headers (Step 5)

All the variables used in the "CarPark" sample program are declared as global variables. The
next step is to declare the variables used in each POU in the POU headers.The quickest way to
do this is to copy the variables in the Global Variable List (��) and then paste them into the
declaration tables of the headers of the individual POUs (�
).

NOTE The keyboard commands for selecting single and multiple lines in tables are listed in the
appendix of the Reference Manual (“Table Keys”).
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7.6.1 Header of the "Control" POU

7.6.2 Header of the "Counter" POU

7.6.3 Header of the "Door_Control" POU
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Fig.7-4: Header of the "Control" POU

Fig.7-5: Header of the "Counter" POU

Fig.7-6: Header of the "Door_Control" POU



7.7 Program the bodies (Step 6)

7.7.1 Body of the "Control" POU

Door control activation

When the main switch is on and no help call or CO2 alarm is registered the OK signal (variable:
"CPark_OK") for the "Door_Control" program organisation unit is set and the
CPark_OK_Lamp is switched on.

Help call and CO2 alarm

As soon as an alarm is registered the motor rolls the car park door up. The motor is reset when
the door activates the upper limit switch ("Door_Open").

Timer activation

When the door is open and the photoelectric barriers at the entrance ("Enter_Car_Gone") and
the exit ("Exit_Car_Gone") do not register any vehicles the timer "Max_Time_Up_C" starts to
count for 60 seconds.
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Fig. 7-7:
Door control
activation

Help call and
CO2-alarm

Timer activation

Time control

Close car park
door

Reset



Time control

The "Time_Control" relay is set as soon as the 60-second period has elapsed.

Close car park door

When no traffic is registered or the main switch is turned off and no alarm is registered the
motor rolls the car park door down into the closed position.

Reset

When no traffic is registered or the main switch is turned off and the door reaches the lower
limit switch ("Door_Closed") both the motor and the "Time_Control" relay are reset.

7.7.2 Body of the "Counter" POU

Entrance

The program counts the cars driving into the car park by incrementing the total number stored
in the "Cars_Number" data register every time a car enters.

Exit

Every time a car drives out of the building the program decrements the number stored in the
data register. The result is that the number always corresponds to the exact number of cars in
the building.
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Fig. 7-8:
Entrance

Exit



7.7.3 Body of the "Door_Control" POU

Conditions for activation of the door control routine

The Door_Control POU can only be executed when the "CPark_OK" variable in the Control
POU is set. "CPark_OK" is only set if

– The main switch is on, and

– No help call alarm is registered, and

– No CO2 alarm is registered.

Open car park door

When the car park door is closed the key switch inside ("Exit_Up") or outside ("Enter_Up") the
building must be operated to open the door.

Reset

The motor is reset when the car park door reaches the upper limit switch ("Door_Open").

Close car park door

When a car passes through the photoelectric barrier after driving in ("Enter_Car_Gone") or out
("Exit_Car_Gone") of the building the motor starts to close the car park door.

Reset

When the door reaches the lower limit switch ("Door_Closed") the motor is reset.
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7.8 Configure the tasks (Step 8)

We have already created the two tasks needed by the program, "Main" and "Door_Operate"
(see Step 2).

The next step is to assign the POUs to the tasks, which are still "empty". Double-click on the
task name in the Project Navigator, then select the pop-up arrow icon in the cell in the POU
Name column, and select the POU from the list displayed.

After assigning the POUs you must then configure the task attributes. Select the task in the
Project Navigator window or open the task configuration table by double-clicking on its name,
then press��or select Information in the Object menu to open the Task Information dia-
logue box.

7.8.1 The "Main" task
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Fig. 7-10:
Assign the POUs "Control" and
"Counter" to the "Main" task.

Fig. 7-11:
Attributes of the "Main" task
Event: TRUE
... i.e. the task's two POUs "Control" and
"Counter" both run continuously.
Priority: 1



7.8.2 The "Door_Operate" Task

NOTE Entry of the project data is now complete.

� Compile the project (Step 9),

� configure the ports of your personal computer (Step 10) and

� download the program to the controller CPU (Step 11).

� Monitoring mode for following the status of the program variables is explained in Step 12.
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Fig. 7-12:
The "Door_Operate" task contains the
POU "Door_Control".

Fig. 7-13:
Attributes of the "Door_Operate" task
Event: "CPark_OK"
... i.e. the associated POU Door_Control is only
activated when the "CPark_OK" signal is set.
Priority: 31



8 Importing

There are two different ways to import projects created with the older MELSEC MEDOC pro-
gramming package for use in GX IEC Developer:

� Import by loading a MELSEC MEDOC print file

� Import by uploading directly from the CPU

Loading a print file to GX IEC Developer

Procedures in MELSEC MEDOC

� Select a file name as the printer port. The extension TMP is added automatically by the
program.

� Make sure that only Instruction List and Name List are selected in the program listing
options. The Header must be switched off!

� Start the print procedure.

Procedures in GX IEC Developer

� Open the body of an existing MELSEC Instruction List program or create a new POU and
specify MELSEC Instruction List as the language. Important: Make very sure that the
POU is declared as a program (PRG).

� In a network click on the left field reading MELSEC.

� Open the POU body, then select Import MEDOC Network in the Tools menu.

� This opens a file selection box. Select the drive and directory, and then select the print file
(TMP) that you want to load and confirm your choice with OK. This opens another dialogue
box.

� Confirm the settings with OK
(MEDOC Program = Instruction List only,
MEDOC Symbolic Names = Name list only).

� If necessary, edit the system variables.

NOTES The structure of MELSEC MEDOC programs can only be remained, if you select MELSEC
mode in the Wizard before!

For further details refer to the Reference Manual
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